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 About Elecosoft Consultec AB 1
Elecosoft® Consultec AB is a Swedish company that has its roots and heart in the construction 
industry and is owned by the publicly-listed UK group Elecosoft plc. Elecosoft Consultec AB was 
the first in the world to create design and construction programs for Microsoft Windows®. 
 
Elecosoft Consultec AB is the leading provider of efficient IT tools for the building, construction 
and MEP industry in Sweden. Elecosoft Consultec AB develops and sells advanced software for 
construction management, project management, cost estimating, planning, price management, 
purchasing, administration and design.  
 
 

 

 Introduction to Bidcon 2
When estimating the cost of a project, it is important to be able to find, quickly and accurately, 
the most cost-effective solutions and to be able to revise your estimation as and when you need 
to. Bidcon® enables you to save time by planning smarter, making more reliable estimations 
and making better choices of material. 
 
Bidcon is available in a number of different versions. This guide is written for the Standard 
version. As a result of this, certain features may be available in your version that are not 
described in this guide. 
 

 

 

 About this guide 3
Elecosoft AB wishes for its customers to gain the maximum benefit from its products. In order to 
make Bidcon even easier to use, we have produced this guide which will walk you through the 
program. This guide assumes that you have basic estimating skills and a basic knowledge of 
Windows. 
 
This guide shows how the program is structured and describes its various elements. It presents 
many features and functions that you may find useful when getting started with estimation work 
in Bidcon. There is also information on how to install Bidcon and information on various icons, 
shortcuts and more. 
 

 

 Technical support 4
Elecosoft operates an accessible Technical Support Department staffed by skilled and 
knowledgeable experts providing support on all of Elecosoft products. 
 
You can telephone Customer Support between the hours of 08:00 and 16:30 GMT.  
Outside these hours you can leave a message on the answer machine and your query will be 
answered as quickly as possible. 
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 Overview of the Bidcon structure 5
Bidcon comprises the following main elements: 
 
 
 
 
 

 Estimation Explorer. 
 

 Spreadsheets (including summary 
sheets). 
 

 Cost library. 
 
 
 
 

You generate estimations by selecting and transferring items from the cost library to a 
spreadsheet and revising them as necessary to suit the project that you are working on. When 
an estimation is finished, you can present it in the form of printed reports in a number of 
different ways, or you can export it to other applications.  
 
 
 

5.1 Estimation Explorer 

The Estimation Explorer displays both current and previously-saved estimations and can be 
customised to display only the estimations that you wish to see. Depending on the way in which 
Bidcon is configured, you use the Estimation Explorer in different ways. Estimations can be 
saved either in a database or as individual files. 
 
We recommend that you save estimations in a database rather than as individual files, as this 
means that they will always appear in the Estimation Explorer, which displays all estimations, 
both closed and open. Estimations that have been saved as individual files appear in the 
Estimation Explorer only if you specifically open them. 
 

 

 

5.2 Spredsheets 

The following spreadsheets are available in the standard installation of Bidcon: 
 

 Net sheet: you use this to enter all normal spreadsheet postings that a project should 
contain. 

 Prelims sheet: you can use this to place your preliminaries in a different spreadsheet to 
the net sheet. 

 Object summary: this summarises all objects in an estimation that contain active 
resources that are associated with costs. 

 Summary: hours and costs from other spreadsheets are transferred here; they can be 
supplemented with additional data to obtain a tender sum. 
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5.3 Cost library 

The cost library is made up of a number of different libraries of design elements (DE), work 
results (WR) and resources (RES). These libraries contain pre-defined data that you can add to 
your estimations, then edit as required for each estimation. You access the various cost libraries 
by clicking the appropriate tab in the Cost Library pane at the bottom of the window. 
 

 Favourites: contains shortcuts to items that you have identified as your favourite items. 
You can choose which items are added to this tab. You can then organise them, using a 
structure of your own, to enable you to access your most regularly-used elements 
quickly and easily. 

 Design Elements: contains design elements, each of which comprises one or more 
work results. 

 Work Results: contains small “recipes” or activities, each of which comprises one or 
more resources and a record of the time consumed. 

 Resources: the lowest elements in an estimation. Resources can be any of the 
following types: Plant (P); Materials (M); Labour (L); Subcontractors (SC); Officials (O); 
Information (I); Subcontractor Tender ([SC]); Material Tender ([M]); and Adjustments 
(A). 

 

 

 

5.4 Glossary of Bidcon terms 

Article 
A specific product that is linked to a material resource. Other items that are referred to as 
“articles” are imported price lists, discount letters and supplier information. 
 
BIM 
Building Information Modelling. BIM is a digital representation of the physical and functional 
characteristics of a facility, such as a building. BIM is a shared knowledge resource for 
information about a facility, which can form a reliable basis for decisions that need to be made 
during the life-cycle of a facility, from the earliest conception, through planning, construction, 
usage and eventual demolition. 
 
Cost library 
Different libraries of design elements (DE), work results (WR) and resources (RES). These 
libraries contain pre-defined data that you can add to your estimations, then edit as required for 
each estimation. 
 
Design element 
An element that comprises one or more work results. 
 
Elecosoft BIMCloud® 
A web-based application that can be used to manage IFC files that are stored in the Cloud. 
 
Estimation Explorer 
The pane on the far left of the Bidcon screen, which you use to manage your estimations. The 
Estimation Explorer displays both current and previously-saved estimations and can be 
customised to display only the estimations that you wish to see. 
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Trade code 
A coding system that can be used to organise and summarise estimation items in 
your own way. If you organise items according to trade code, you can make selections and 

summarise according to trade codes when printing. 

You can choose to create trade codes that are unique to each spreadsheet (this is the most 
common way of using trade codes), or to create a series of trade codes in the system database 
that can be applied to items in all of your estimations. 
 
Net sheet 
A spreadsheet in which you enter all of the normal spreadsheet postings that a project should 
contain. 
 
NRM 
New Rules of Measurement: a standard set of measurement rules and essential guidance for 
the cost management of construction projects and maintenance works. Bidcon supports the use 
of NRM 1 and NRM 2 to structure information. 
 
Object summary 
A pane of the Bidcon screen that summarises all objects in an estimation that contain active 
resources that are associated with costs. 
 
Posting 
An item in a spreadsheet – an element of an estimation. 
 
Prelims sheet 
A spreadsheet in which you can enter your preliminaries – if you wish to place them 
in a spreadsheet other than the net sheet. 
 
Quantity posting 
An item in a spreadsheet – an element of an estimation – against which a cost had not originally 
been entered. Quantity postings can be converted into work results or exchanged with items 
from the cost library. 
 
Resource 
The lowest elements in an estimation. Resources can be any of the following types: Plant (P); 
Materials (M); Labour (L); Subcontractors (SC); Officials (O); Information (I); Subcontractor 
Tender ([SC]); Material Tender ([M]); and Adjustments (A). 
 
Spon’s 

A series of price books that can be used in estimating. 

 

Summary 
A spreadsheet into which hours and costs from other spreadsheets are transferred; they can be 
supplemented with additional data to obtain a tender sum. 
 
Work result 

An element that comprises one or more resources. 

 

 

 

 



6 The recommended workflow when using Bidcon BIM 

9 

 The recommended workflow when using 6
Bidcon BIM 

 
In order to work in a structured manner in Bidcon, we recommend the following workflow. 
 

1. Create a new estimation. The standard procedure is to create an estimation from a 
template and edit it to record details of the individual estimation. 
 

2. If you save your estimations in the system database, every estimation is saved 
automatically; if you save your estimations as individual files, you must save them 
manually and give them a filename. 

 
3. The net sheet opens automatically, which means that you can enter postings into the 

estimation immediately. You structure an estimation with groups and/or spreadsheet 
parts; the IFC model that you are using may provide adequate groups and parts. If you 
choose to produce a detailed estimation, it is useful to create estimation parts 
(substructure, frame, roof, etc). Working with your own custom templates will make the 
process even faster. 

 
4. Access the appropriate IFC model, if one is to be used in the estimation. You can use 

IFC models that are stored locally, or ones that are stored in the Elecosoft BIMCloud. 
 

5. Transfer items into the net sheet, either from the cost library, stating quantities each 
time you transfer an item, or by using one of the automated import methods, such as 
from a bill of quantities or from an IFC model. 

 
6. Check and adjust the content of the transferred items. Verify that each item has the 

correct content; individual projects may set specific requirements. 
 

7. In addition, you have the option to make manual postings into the net sheet, specifying 
the appropriate quantity, material, unit and time to create postings with the appropriate 
material and labour resources. 
 

8. Use the object summary to review the resources that are currently used in the 
estimation and to control and adjust prices and quantities. You can use filters in the 
object summary to get a good overview of the resources that provide significant costs. 
When a request for tender has been imported back into Bidcon, the prices appear here 
and the selection can be edited. 
 

9. Produce a wide range of reports, for example to view summaries to varying levels, 
based on the structure of the estimation, the NRM code or the trade code. 

 
10. Use the summary to add more information such as calculations and key figures to 

retrieve a tender sum. 
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 Getting started with Bidcon 7
This section describes how to create and work with a simple estimation using Bidcon. 
 
 
 
 

7.1 Creating an estimation 

1. Launch Bidcon. 
 

2. Click  to create a new estimation. The New Estimation dialog appears: 

 

 
 

3. Select the template on which to base your estimation – or click to create an 
estimation without using a template – and click OK. The use of templates where 
possible is strongly recommended as it can save you much time. The Estimation 
Properties dialog appears: 
 

 
 

Other than the fields that are pre-populated with default information, the only fields that 
you need to enter information into on this dialog are Project ID and Labour resource 
(the latter is located on the Factors tab). 
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4. Enter information relating to the project in the Project group of fields. Although many of 
these fields are not mandatory, entering information into them can be useful when 
generating reports or reviewing information at a later date. 
 

5. Enter information relating to the estimation in the Estimation group of fields. If the Low 
radio button is selected in the Protection level field, all users will have permission to 
open and edit the estimation. Some of the information in the Project and Estimation 
groups of fields is used in the headers of reports 

 
6. On the Time and Price tab, select the time list that applies to the estimation in the Time 

tables field, if applicable. 
 

7. If you want to apply a default cost per hour to all labour resources, select the General 
price for the resource type labourer check box and enter the amount in the field to the 
right. If you are using Spon’s price books in your estimations, it is best not to enter a 
default cost per hour, as the cost per hour will be taken from the price books 
themselves. 
 

8. Select the price and discount list to use in the estimation in the Price and discount list 
field. 
 

9. Specify the type of pricing to use in the Price type field. 
 

10. Specify the type of price to accept in this estimation in the Price selection field. For 
example, you can choose to always accept the lowest price, the highest price, or the 
price that appears first in the price list. 

 
11. Click the Miscellaneous tab. Use the fields on this tab to specify the language in which 

to produce the estimation, the language to use in printouts and the currency to use. 
 

12. Click the Factors tab. 

 

13. Specify the human resource who is associated with the manual spreadsheet entries in 
the Labour resource field. 

 
14. Specify the factor or markup percentage to add to labour resources in this estimation in 

the Value and Percentage fields. 
 

15. If time lists are in use, specify the appropriate object in the Object type field. 
 

16. Specify any location factor to apply to the estimation in the Location factor field. 
 

17. Enter the total building size in the Area (m2) field. 
 

18. If the bid price is pre-set, enter this in the Bid price field. 
 

19. Click OK. The estimation is saved and appears in the Estimation Explorer. The 
estimation is opened according to the template that you used. Initially, the net sheet 
appears. 
 

 
  

Once you have created an estimation, you can view its properties at any time by 

selecting the estimation and either clicking or selecting Estimation Properties 
from the Estimation menu. 
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7.2 Structuring the net sheet 

To get a good overview of the contents of a spreadsheet, it may be helpful to create estimation 
groups and estimation parts for different spreadsheet entries. Some of your templates may 
already have a pre-set structure in which this has been done. The benefits of splitting entries 
into groups and parts depend on the type of project you are working on. For example, reports 
and exports can be much more dynamic. Some of this can be done automatically when adding 
new items, depending on the type of transfer or import, the content, and the specific settings 
at the time. Groups form the top-level layer of the hierarchy of items within an estimation; within 
the lowest group are parts; and within each part are postings that have been transferred from 
the cost library or that have been entered manually. You should name and organise groups and 
parts in such a way that you will be able to recognise them when you are producing your 
estimation. 
 
To create a new estimation group or estimation part: 
 

1. Right-click the net sheet and select either New Group or New Part. The New Group or 
New Part dialog appears. 
 

2. Enter details of the group or part into the dialog and click OK. 
 

3. Create as many estimation groups and parts as you need. 

 

 

 

7.3 Transferring postings to the net sheet from the 

cost library 

When transferring postings to the net sheet – either from the cost library, from an IFC model or 
from an imported bill of quantities – you can locate postings within groups and parts manually or 
you can locate them automatically according to NRM code.  
Doing the latter enables you to build up the structure of an estimation automatically, as if a part 
does not already exist, a group and a part are created automatically when you post according to 
NRM code. 
 
Note that for the structure to be build up automatically when importing a bill of quantities, either 
the NRM1 or NRM2 column must be present and must have been mapped during the import. 
 

7.3.1 Design Element cost library 

To transfer a selection from the Design Element cost library to the net sheet: 
 

1. In the Cost Library pane, click the Design Element tab. 
 

2. Select the design elements that best match the parts or groups in the net sheet and 
drag and drop them onto the relevant part or group. Each time you drag and drop, the 
Transfer to Worksheet dialog appears, with the amount of the current posting 
indicated: 
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3. Enter a quantity in the Quantity field. 
 
4. The Add last radio button is selected by default. This indicates that the posting will be 

placed after the last existing posting. If you would rather place the posting before the 
first existing posting, click the Add first radio button. 
 

5. The Estimation part radio button is selected by default. This indicates that the design 
element will be posted into the part that you select in the field to the right. If you would 
rather post the design element into the appropriate part based on the NRM code, click 
the According radio button and specify the way in which to do this in the fields to the 
right of it. If the part does not already exist, a group and a part are created 
automatically. Posting according to NRM code helps you to build up the structure of an 
estimation as the appropriate groups and parts are created automatically. 
 

6. Click OK. A posting appears in the net sheet. 
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Once you have transferred a posting to the net sheet, it is important to verify that 
the details of the posting are correct for the current estimation and edit them if 
required. To do this: 
 

1. Double-click the posting in the net sheet. The Edit – Design Element dialog appears: 
 

 
 

This dialog has a number of buttons, including the following: 

 
 

2. Edit the posting as required, then click OK. 
 

Note that the changes made here affect only the current posting (which has been transferred to 
the spreadsheet), and do not affect the design elements in the Design Element cost library. 
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7.3.2 Work result cost library 

When a specific material or other basic resource is needed that is not composed of several 
materials you use Work Result cost library. You can base the material or resource on the work 
result that best matches the project requirements, then edit the details of the resulting posting to 
suit the project’s requirements. 
 

To transfer a selection from the Work Result cost library to the net sheet: 
 
1. In the Cost Library pane, click the Work Result tab. You can locate the appropriate work 
result in a number of ways. One method is described below. 
 
2. Enter a keyword in the first row of the Name column. The work results that match the filter 
appear in the list. 
 
3. To transfer a work result to the net sheet, drag and drop it or double-click the row. The 
Transfer to Worksheet dialog appears, with the amount of the current posting indicated: 

 

 

 
4. Enter a quantity in the Quantity field. 
 
5. The Add last radio button is selected by default. This indicates that the posting will be placed 
after the last existing posting. If you would rather place the posting before the first existing 
posting, click the Add first radio button. 
 
6. The Estimation part radio button is selected by default. This indicates that the work result will 
be posted into the part that you select in the field to the right. If you would rather post the work 
result into the appropriate part based on the NRM code, click the According radio button and 
specify the way in which to do this in the fields to the right of it. If the part does not already exist, 
a group and a part are created automatically. Posting according to NRM code enables you to 
build up the structure of estimation automatically. 
 
7. Click OK. A posting appears in the net sheet. You can now edit the posting to verify that its 
details are correct for the current estimation and edit them if required. 
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7.3.3 Exchanging postings in the spreadsheet 

You can use the Exchange feature to replace individual postings in the net sheet or 
object summary with the appropriate item from the cost library: 
 

1. Right-click the posting that you want to change and select Exchange. The Add… 
dialog appears: 
 

 
 

2. In the right pane of the dialog, the posting that you want to replace is highlighted and 
automatically selected. If there is any near reference to it in the cost library, this is 
indicated. The left pane of the dialog displays the various groups, from which you can 
select the new posting that you want to select. 
 

3. Click a different posting in the right pane to view details of what will be exchanged. If 
you happy with what will happen, double-click the different posting to execute the 
exchange and close the dialog.  

 
 
In addition to being able to replace individual postings one at a time, you can replace multiple 
postings in the net sheet or object summary with the appropriate items from the cost library: 
 

1. Click . The Replace Quantity Postings dialog appears: 
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The top pane of the dialog lists the postings in the estimation. The cost library appears in the 
bottom pane. 
 

2. Click a posting in the top pane, then double-click the item in the cost library that you 
want to replace the posting with. Details of the replacement appear to the right of the 
posting. 

 
3. Follow the above step as many times as required to replace all of the postings with 

items from the cost library. 
 

4. When you have finished replacing postings, click OK to execute the exchanges and 
close the dialog. 

 
 
If cost or time information has been added to a quantity posting, as an alternative to the steps 

above, you can click to convert the quantity posting into a work result manually. 
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7.4 Working with the object summary 

You use the object summary to view a summary of all items in an estimation against which a 
cost has been entered. You can easily group and adjust the rates of any item. Double-click the 
object summary in the Estimation Explorer in order to view it: 
 

 
 
 
The object summary spreadsheet appears in its own tab: 
 

 
 
If you are using vendor price lists you can see the linked prices the vendor details. There are 
three different sources of cost: Manual, System or Linked. Usually, costs come from a price 
book or from the cost library. This corresponds to “System”. If a vendor price list is used the 
costs might be “Linked” to that. You can enter values in the Cost (M) /unit column to represent 
“Manual” costs. 
 
You can see which items have the greatest impact on price in the estimation, by clicking on the 
Net Cost/Total heading to sort by price. 
 
Click the Cost (S)/unit heading to see if there are any items that are missing costs. 
 
Note that you can change the resource names in an estimation using the object summary. 
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7.5 Printing reports 

You can use Bidcon’s reports to present your estimations in a variety of formats. Bidcon uses 
report templates to determine the level of detail, the appearance and the default output format 
for each report. You can edit these templates to configure Bidcon’s reports to suit your needs. 
 

7.5.1 Editing a report template 

To edit a report template: 
 

1. Click the File menu, then select Print – Reports. The Report Templates dialog 
appears: 
 

 
Each row in the dialog represents a different report. 

 

2. Select the report whose template you want to edit and click . The Edit Report 
dialog appears. 
 

3. Use this dialog to specify the level of detail, the appearance and the default output 
format for the report. 
 

Note that you can use the Print to field on the General tab of the dialog to specify that 
reports should be printed as PDF files or exported to a different file format, for example 
Microsoft Excel®, by default. Note also that if you select the Fast print check box on the 
General tab of the dialog, the report will be printed instantly to the specified printer or 

exported to the specified file format when you select the report and click  on the 
Report Templates dialog. 
 
4. Click OK to save your changes to the report template. 
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7.5.2 Previewing and printing a report 

 

To preview and print a report: 

1. Click the File menu, then select Print – Reports. The Report Templates dialog 
appears, as illustrated above. 
 

2. Select the reports that you want to print. You can select more than one at a time. 
 

3. Click to preview a report prior to printing. The Report Filter dialog appears. You 
use this dialog to specify the way in which you want the report to appear and the 
sections of the estimation on which you want to report. 

 
4. Click OK. The report is generated and appears on the screen. 

 

5. Click . The Print dialog appears. You can use this dialog to select a printer. 
 

6. If you are happy with the report, click OK to print it. 

 

 
 

7.5.3 Printing a report without previewing it 

If you have printed a report before, you may not want to preview it every time you print it. 
 
To print a report without previewing it beforehand: 
 

1. Click the File menu, then select Print – Reports. The Report Templates dialog 
appears, as illustrated above. 
 

2. Select the reports that you want to print. You can select more than one at a time. 
 

3. Click  . If you have selected the Fast print check box on the General tab of the 
Edit Report dialog, the report is printed instantly to the specified printer or exported to 
the specified file format; if you have not selected the Fast print check box, the Report 
Filter dialog appears. You use this dialog to specify the way in which you want the 
report to appear, the sections of the estimation on which you want to report and the 
printer or file format that you want to use. 
 

5. Click OK to print the report. 
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7.6 Working with the summary 

The purpose of the summary is to automatically collect all information from the different 
spreadsheets and to present a tender sum. Double-click the summary sheet in the Estimation 
Explorer in order to view it: 

 
 
The summary spreadsheet appears in its own tab: 
 

 
 
The summary contains different totals from the spreadsheets in the upper pane. 
It also shows the total time included in the spreadsheet entries. 
 
Different colours are used to indicate where the information comes from: 
 

 Yellow indicates imported values from spreadsheets. 

 Light blue indicates manual entries/values. 

 Green indicates summarised values. 
 

In order to obtain a final bid amount, enter the appropriate data in the light blue boxes. 
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 Working with the Cost Library 8
 
The cost library is made up of a number of different libraries of design elements (DE), work 
results (WR) and resources (RES). These libraries contain pre-defined data that you can add to 
your estimations, then edit as required for each estimation. You access the various cost libraries 
by clicking the appropriate tab in the Cost Library pane at the bottom of the window. As the cost 
library can contain far more items than can easily be displayed on the screen at one time, there 
are a number of ways in which to locate the items that you need. 
 
 
 
 

8.1 Groups 

Bidcon displays pre-prepared groups to the left of the cost library that you are currently viewing: 

 

 
 

 

This hierarchical list displays the groups relevant to the cost library tab that is currently selected. 
This includes pre-populated (system prices) groups as well as custom groups. 
To make it easier to find the items that you need, you can expand and contract individual 

groups using the  button.  
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8.2 Filtering for items in the cost library 

You can filter for items in the cost library, to make it easier to locate the items that you need. To 
do this, enter text in the field at the top of the cost library. The list of items in the cost library is 
updated to display only items that match the text you have entered. 
 

In the illustration below, “Manholes” has been entered as a filter and the cost library displays 

only those items that include this word in their description: 

 

 
 

 

8.3 Saving frequently- used items as “favourites” 

You can save items that you use frequently in a cost library into a list of “favourites”.  

To do this, select the check box in the Favourites column, as illustrated below: 

  
 

To display your favourite items within a cost library, click  Click the button again to return to 
displaying all items within the cost library.To remove an item from your list of favourites, clear 
the check box in the Favourites column. A dialog appears, asking you to confirm that you want 
to remove the item. 
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8.4 Using the favourites cost library 

You can use the Favourites cost library to view the items that you have added to your list of 
favourites in all cost libraries. To display the Favourites cost library, click the Favourites tab in 
the Cost Library pane: 
 

 
 

This enables you to find your favourite items quickly and easily, regardless of the cost library in 
which they are located. You can group the items in the Favourites cost library to make it easier 
to locate the items that you want. This is particularly useful if you have added a large number of 
items to your list of favourites. 
 
To create a group in the Favourites cost library: 
 

1. If you have already created one or more groups, click the location in the group hierarchy 
at which to create a new group. 
 

2. Click .   The Add New Group dialog appears: 
 

 
  

3. Enter a name to apply to the group and click OK. The group is added to the hierarchy of 
groups and the cost library displays the group – as there are currently no items in the 
group, no items are displayed. 
 

4. Click View All to view all of the items in the Favourites cost library: 
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5. You can now add items to the group by selecting them, then dragging and  dropping 

them into the group:  

 

 
 

 

 

8.5 Displaying the frequently-used items in a cost 

library 

You can quickly locate the items that are used most frequently in a cost library by clicking . 
The cost library displays the most frequently-used items.Click the button again to return to 
displaying all items within the cost library. 
 
You can specify the number of times an item must be used for it to appear in themost-used list 
using the Most used collection count field on the User Settings tab of the Options dialogue. 
 
 
 
 

8.6 Searching for items 

You can use various criteria to search for items in the cost library, in price lists and in 
spreadsheets. You can save up to five frequently-used search criteria as shortcuts, enabling 
you to carry out these searches more quickly. To carry out a simple search: 
 

1. Enter keywords into the Search field at the top-right of the screen and click  
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2. The Search pane appears, displaying items that match your search criteria: 

 
 

3. Select an item and click  to locate the item in the appropriate cost library, price list or 
spreadsheet. 

 
 
To carry out an advanced  search: 

 

1. In the appropriate cost library, price list or spreadsheet, click The search pane 
appears. 

 

 
 

2. Specify where you want to search using the fields in the Search in group 
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3. Enter keywords into the Search criteria field and click Search. The search list is 

updated with items that match your search criteria: 

 
 

 
 
 

4. Select an item and click  to locate the item in the appropriate cost library, price list or 
spreadsheet. 

 
 
 

 

 Working with resources 9
 
Resources are the lowest-level elements in an estimation. Resources can be any of the 
following types: Plant (P); Materials (M); Labour (L); Subcontractors (SC); Officials (O); 
Information (I); Subcontractor Tender ([SC]); Material Tender ([M]); and Adjustments (A). 
 
In addition to the default system resources, which are available to all users throughout Bidcon 
regardless of the database they are using, you can create and maintain your own custom and 
personal resources, which you can then use in multiple estimations. Custom resources are 
available to all users in the current database; personal resources are available to you only. 
 
A price should be assigned to each resource. The system price can often be a little higher than 
the net price, as the system price can be considered a “basic rate”.  
 
When you transfer a resource to a spreadsheet, it becomes a Work Result resource 
automatically. 
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9.1 Creating a new group in which to store resources 

To create a new group in which to store resources: 
 

1. In the Cost Library pane, click the Resource tab:  
 

 
 

2. Click and select All from the menu that appears to display system-wide resources, 
custom resources and personal resources. 
 

3. Click the location in the group hierarchy at which to create a new group. 
 

4. Click  The Add New Group dialog appears. 
 

5. Enter a name to apply to the group and click OK. The group is added to the hierarchy of 
groups and the cost library displays the group – as there are currently no resources in 
the group, no items are displayed.  
 

 
 

9.2 Creating a new resource 

To create a new resource, based on an existing resource: 
 

1. Click and select System from the menu that appears to display only system-wide 
resources. 

 
2. Locate the resource that you want to copy, either by using the hierarchy, by filtering or 

by searching – or by using a combination of these methods. 
 

3. Right-click the resource and select Edit. The Edit Resource dialog appears: 
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4. Click the dropdown to the right of the  control and select Copy as Custom or Copy 
as Personal – depending on whether you want to makethe new resource available to 
all users in the current database or to yourself only. The Add Resource dialog – which 
looks almost identical to the dialog above – appears, displaying details of the copy of 
the resource. 
 

5. Enter a name for the new resource in the field at the top of the dialog and enter any 
other details that differ from the original resource. 

 

6. Click  to the right of the Group of field. The Resource dialog appears: 
 

 
 

7. Select the group to which the new resource will belong and click OK to return to the 
Add Resource dialog. 
 

8. Click OK. The new resource appears in the Resource cost library. If you have created 
the resource as a custom resource, a key symbol appears against it; if you have 
created it as a personal resource, a heart symbol appears against it. 
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  Working with work results 10
 
A work result consists of one or more resources. You can use work results to build up design 
elements. 
 
In addition to the default system work results, you can create and maintain your own custom 
work results, which you can then use in multiple estimations. 
 
In addition to the default system work results, which are available to all users throughout Bidcon 
regardless of the database they are using, you can create and maintain your own custom and 
personal work results, which you can then use in multiple estimations. Custom work results are 
available to all users in the current database; personal work results are available to you only. 
 
 
 

10.1 Creating a new group in which to store work 

results 

To create a new group in which to store work results: 
 

1. In the Cost Library pane, click the Work Result tab:       

 

 
 

2. Click  and select All from the menu that appears to display system-wide work 
results, custom work results and personal work results. 
 

3. Click the location in the group hierarchy at which to create a new group. 
 

4. Click  The Add New Group dialog appears.  
 

5. Enter a name to apply to the group and click OK. The group is added to the hierarchy of 
groups and the cost library displays the group – as there are currently no work results in 
the group, no items are displayed.  
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10.2 Creating a new work result 

To create a new work result, based on an existing work result: 
 

1. Click  and select System from the menu that appears to display only system-wide 
work results. 

 
2. Locate the work result that you want to copy, either by using the hierarchy, by filtering or 

by searching – or by using a combination of these methods. 
 

3. Right-click the work result and select Edit. The Edit Work Result dialog appears:  
 

 
 

4. Click the dropdown to the right of the  control and select Copy as Custom or Copy 
as Personal – depending on whether you want to make the new work result available to 
all users in the current database or to yourself only. The Add Work Result dialog – 
which looks almost identical to the dialog above – appears, displaying details of the 
copy of the work result. 
 

5. Enter a name for the new work result in the field at the top of the dialog and enter any 
other details that differ from the original work result. 

 

6. Click  to the right of the Group of field. The Work Result dialog appears. 
 

7. Select the group to which the new work result will belong and click OK to return to the 
Add Work Result dialog. 

 
8. Double-click one or more of the resources that are listed in the lower part of the dialog 

to edit their details as required. 
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9. Add layers or manual resources as needed, and adjust the consumption factor if the 
ratio is not 1:1, as described in section 12.2, Creating design elements and work results 
manually in the spreadsheet. 

 
10. When you have finished editing the new work result, click OK. The new work result 

appears in the Work Result cost library. If you have created the work result as a custom 
work result, a key symbol appears against it; if you have created it as a personal work 
result, a heart symbol appears against it.  
 

Once you have created the work result, you can edit its resources and consumption factors by 

selecting the work result and clicking . 
 

 
 
 

 Working with design elements 11
A design element consists of one or more work results.In addition to the default system design 
elements, which are available to all users throughout Bidcon regardless of the database they 
are using, you can create and maintain your own custom and personal design elements, which 
you can then use in multiple estimations. Custom design elements are available to all users in 
the current database; personal design elements are available to you only. 
 
Some design elements include a dynamic, navigable illustration of the design element, as in the 
example below:  
 

 
 
You can print these illustrations – together with a technical summary of the design 

element – by clicking  at the top-left of the illustration.  
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11.1 Creating a new group in which to store design 

elements  

To create a new group in which to store design elements: 
 

1. In the Cost Library pane, click the Design Element tab:  

 

 
 

2. Click  and select All from the menu that appears to display system-wide design 
elements, custom design elements and personal design elements. 

 
3. Click the location in the group hierarchy at which to create a new group. 

 

4. Click The Add New Group dialog appears.  

 

5. Enter a name to apply to the group and click OK. The group is added to the hierarchy of 
groups and the cost library displays the group – as there are currently no design 
elements in the group, no items are displayed.  

 
 

11.2 Creating a new design element 

To create a new design element, based on an existing design element: 

1. Click  and select System from the menu that appears to display only system-wide 
design elements. 

 
2. Locate the design element that you want to copy, either by using the hierarchy, by 

filtering or by searching – or by using a combination of these methods. 
 

3. Right-click the design element and select Edit. The Edit Design Element dialog 
appears:  
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4. Click the dropdown to the right of the  control and select Copy as Custom or Copy 
as Personal – depending on whether you want to make the new design element 
available to all users in the current database or to yourself only. The Add Design 
Element dialog – which looks almost identical to the dialog above – appears, displaying 
details of the copy of the design element. 
 

5. Enter a name for the new design element in the field at the top of the dialog and enter 
any other details that differ from the original design element. 

 

6. Click  to the right of the Group of field. The Design Element dialog appears. 
 

7. Select the group to which the new design element will belong and click OK to return to 
the Add Design Element dialog. 

 
8. Double-click one or more of the work results that are listed in the lower part of the dialog 

to edit their details as required.  
 

9. Add layers or manual resources as needed, and adjust the consumption factor if the 
ratio is not 1:1, as described in section 12.2, Creating design elements and work results 
manually in the spreadsheet. 

 
10. When you have finished editing the new design element, click OK. The new design 

element appears in the Design Element cost library. If you have created the design 
element as a custom design element, a key symbol appears against it; if you have 
created it as a personal design element, a heart symbol appears against it. 
 

 
Once you have created the design element, you can edit its resources and consumption factors 

by selecting the work result and clicking   
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  Making manual postings in a spread sheat 12
 
It may be necessary sometimes to add items to an estimation that have not been retrieved from 
a reference book. You can do this by adding items manually to a spreadsheet.  
 
 
 

12.1 Adding manual spreadsheat entries 

To add an item to a spreadsheet manually: 
 

1. Select the row in the spreadsheet beneath which you want to create the manual entry. 
 

2. Right-click the row and select Manual Posting from the menu that appears. The 
Manual Posting dialog appears:  

 

 
 

3. Enter information about the manual posting – name, quantity, unit, etc – into the fields 
of the dialog and click OK. The entry is added as a new row to the spreadsheet. Many 
of the cells in the row are coloured white, which means that you can edit them directly in 
the spreadsheet. 
 

If you specify cost or time information when creating the manual posting, a work result is 
created and you can edit in the normal way. If you do not specify this information, a quantity 
posting is created. If this is the case, you need to convert the quantity posting into a work result 
or design element before its quantities are included in the estimation. Refer to section 7.3.3, 
Exchanging postings in the spreadsheet, for details of how to do this. 
 
Note that if you enter details relating to costs and time, a corresponding resource is 
automatically created within the work result in the estimation. If you enter values of zero, a 
resource is created with zero values, which you can then edit. If you do not enter anything into 
these fields, a resource is not created.  
 
 
 

12.2 Creating design elements and work results 

manually in the spread sheat 

To create a new design element or work result manually in the spreadsheet: 
 

1. Select the row in the spreadsheet beneath which you want to create the manual entry.  
 

2. Click the dropdown to the right of the control and select the type of item that you 
want to create from the menu that appears. The appropriate Add dialog appears – for 
example, if you choose to create a work result, the Add Work Result dialog appears: 
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3. Enter details of the new item into the dialog. 
 

4. Click  The Resource dialog appears. If you are creating a design element, you use 
this dialog to select the work result that you want to assign to the design element; if you 
are creating a work result, you use the dialog to select the resource that you want to 
assign to the work result:  
 

 
 

5. Select the work result or resource that you want to assign and click   
 

6. Click Close. 
 

7. Click OK to close the Add dialog. The entry is added as a new row to the spreadsheet.  
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  Copying items from one spreadsheet to 13
another 

t is possible to copy items from one spreadsheet to another. This may be useful if you are 
producing a new estimation in which you want to use elements from an old estimation.To copy 
an item from one spreadsheet to another: 
 

1. Open the spreadsheet into which you want to copy the item. 
 

2. Open the estimation that contains the item that you want to copy. The two spreadsheets 
are displayed, with each one in a separate tab. 

 
3. Right-click one of the tabs and select either New Horizontal Tab Group or New 

Vertical Tab Group. Both spreadsheets are displayed at the same time. 
 

4. In the spreadsheet from which you want to copy the item, select the row that you want 

to copy and click  or press CTRL C. You can select more than one row at a time. 
 

5. In the spreadsheet to which you want to copy the item, select the row beneath which 

you want to insert the copied items and click  or press CTRL V. 
 

6. Close the tab that displays the spreadsheet from which the item was copied. 
 
You can also copy items from one spreadsheet to another by dragging and dropping.  
 
 
 

  Creating estimation based on IFC models 14
 
You can use Bidcon to produce estimations that are based on 3D models that have been saved 
in IFC format – these are referred to as “IFC files”, or “IFC models”. Bidcon is able to work  with 
IFC models that are stored locally, or in the Elecosoft BIMCloud. If you associate an estimation 
with an IFC model, you can “take off” objects from within the IFC model and add them to a 
group in a Bidcon spreadsheet, which enables you to produce estimations that refer directly  to 
the different elements within IFC models.  
 
If an IFC model has been used with an estimation before, the IFC model is opened when you 
open the estimation and any links between the estimation and the IFC model are retained; if you 
have not yet used an IFC model with an estimation, you need to associate the IFC model with 
the estimation.  

 

14.1 Associating an IFC model with an estimation 

In order to build an estimation from an IFC model, you must associate the IFC model with the 
appropriate estimation in Bidcon. The way that you do this differs, depending on whether the 
IFC model is stored locally, or in the Elecosoft BIMCloud. 
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14.1.1 Associating a locally-stored IFC model with an estimation 

 
To associate a locally-stored IFC model with estimation: 
 

1. If you have not already done so, create or open an estimation in Bidcon with which you 
want to associate an IFC model. 
 

2. From the BIM menu, select Local IFC Files. The Local IFC Files pane appears, with 
“No IFC File Selected” displayed: 

 

 
 

3. In the toolbar of the Local IFC Files pane, click . The Open dialog appears. 
 

4. Browse for the IFC model that you want to associate with the estimation, then select it 
and click OK. The selected IFC model appears in the Local IFC Files pane: 
 

 
 
 
You can use the properties tabs in the lower portion of the pane to view information about the 
IFC model and about any items that are currently selected in the model. 
 

14.1.2 Associating an IFC model in the Elecosoft BIMCloud with an 

Estimation 

 
In order to use IFC models that have been stored in the Elecosoft BIMCloud, you must first 
have been set up as a user in the Elecosoft BIMCloud itself. To associate an IFC model that is 
stored in the Elecosoft BIMCloud with an estimation: 
 

1. If you have not already done so, create or open an estimation in Bidcon with which you 
want to associate an IFC model. 
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2. From the BIM menu, select Elecosoft BIM Cloud. The Elecosoft BIM Cloud pane 
appears: 

 

 
 

3. Select the type of account with which to log into the Elecosoft BIMCloud. You can log 
into the Elecosoft BIMCloud using a Yahoo!®, Google® or Windows Live™ account. 
 

4. Enter your login user name and password; if you have logged into the Elecosoft 
BIMCloud using this account previously, you may not need to enter your user name 
and password again. 

5. In the toolbar of the Elecosoft BIM Cloud pane, click . The Select Project dialog 
appears: 

 

 
 

6. A list of the available IFC models appears in the dialog. Select the IFC model that you 
want to associate with the estimation and click OK. The selected IFC model appears in 
the Elecosoft BIM Cloud pane. 

 
You can use the properties tabs in the lower portion of the pane to view information about the 
IFC model and about any items that are currently selected in the model. 
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14.2 Using the toolbars in the Local IFC Files and 

Eleco BIM Cloud panes 

 
A toolbar is displayed at the top of the Local IFC Files and Eleco BIM Cloud panes. The controls 
on these toolbars are described below. Most controls appear on both toolbars, although some 
controls (marked with an asterisk below) appear on the Eleco BIM Cloud pane toolbar only. This 
reflects the fact that some functionality is available only for IFC files that are stored in the 
Elecosoft BIMCloud. 
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14.3 Switching between orthogonal and perspective 

modes 

You can display IFC models in two different modes: 
 

 Orthogonal mode, in which a model is drawn with parallel lines (ie lines that do not 
converge at a distant vanishing point), meaning that objects remain the same size 
regardless of their distance. 

 
 Perspective mode, in which a model is drawn as it is seen by the eye, with objects 

appearing smaller as their distance from the observer increases and with the size of the 
objects’ dimensions along the line of sight being relatively shorter than dimensions 
across the line of sight.  

 
 
To toggle between displaying an IFC model in orthogonal mode and perspective mode, do 
either of the following: 

o In the toolbar of the Local IFC Files or Eleco BIM Cloud pane, click  . 
o Right-click the Local IFC Files or Eleco BIM Cloud pane and select Perspective 

Mode from the menu that appears. 
 

14.3.1 When to use the orthogonal and perspective modes 

 

Orthogonal and perspective modes are both useful in different situations: 

 Orthogonal mode enables you to judge dimensions and proportions more accurately, 
as each line of 1 unit’s length appears to have the same length everywhere in a model. 
When in orthogonal mode, you can rotate IFC models easily to view them from all 
available angles. 
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 Perspective mode gives you a realistic impression of what a building will actually look 
like. It has depth, which makes it easier to judge distances. In addition to this, you can 
“walk through” a building when you view an IFC model in perspective mode, which 
enables you to see buildings from the inside. 

 
Note that the actions of the mouse differ depending on the current display mode, 
and that you must turn on perspective mode if you want to be able to “walk 
through” a building. 
 
 
 

14.4 Navigating around IFC models 

You navigate around IFC models using the mouse. The actions of the mouse 
controls differ depending on whether you are viewing an IFC model in orthogonal 
or perspective mode. 
 

14.4.1 Navigating around IFC models in orthogonal mode 

 

Moving an IFC model around 
When you move an IFC model around in orthogonal mode, your viewpoint over the model does 
not change; if you are currently looking at the front elevation of a building, you remain looking at 
the front elevation as the model moves. This is illustrated below, first in a sequence of images in 
which an IFC model is being moved to the right and then in a sequence of images in which an 
IFC model is being moved downwards: 
 

 

 
 
To move an IFC model around: 
 

1. Click and hold down the right mouse button on the IFC model. A dot appears on the 
model at the point at which you have clicked. 
 

2. Keeping the right mouse button held down, drag the mouse around. The IFC model 
moves around the pane in the direction in which you move the mouse, following the 
mouse pointer. For example, if you move the mouse away from you, the model moves 
upwards; if you move the mouse to the right, the model moves to the right. 
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3. Release the right mouse button when the IFC model appears in the desired location. 
 
 
You can also move IFC models around using the arrow keys on the keyboard. 
 
Rotating an IFC model around a pivot point 
 

1. Click and hold down the left mouse button on the IFC model at the point around which 
you want to rotate the model. A dot indicating the pivot point appears on the model at 
the point at which you have clicked. In the illustration below, the left mouse button has 
been clicked and held down at the furthest right-hand corner of the roof. This is the pivot 
point around which the model will rotate: 
 

 

 
 

2. Keeping the left mouse button held down, drag the mouse around. The IFC model 
rotates around the pivot point, which remains highlighted by the dot on the model. 

 

 
 

3. Release the left mouse button to stop rotating the model around the pivot point. 
 

You can also rotate IFC models by holding down SHIFT or CTRL and using the arrow keys on 
the keyboard. You can achieve a different type of rotation, depending on which key you hold 
down. 
 
 
Zooming in and out of an IFC model 
If your mouse is equipped with a scroll wheel, you can use this to zoom in and out of an IFC 
model. 
 
To zoom into an IFC model: 
 

1. Click and release the left mouse button on the IFC model at the point at which you want 
to zoom in. In doing this, you may select an object within the IFC model, as in the 
illustration below: 



14 Creating estimation based on IFC models 

44 

 

 
 

2. Move the mouse’s scroll wheel away from you. The view of the IFC model zooms in 
with its focus on the point at which you clicked: 
 

 
 

3. Stop moving the scroll wheel when the IFC model appears at the required zoom level; if 
you move the mouse around while zooming in, the focal point of the zoom changes. 

 
 
To zoom out of an IFC model: 
 

1. Click and release the left mouse button on the IFC model. In doing this, you may select 
an object within the IFC model. 
 

2. Move the mouse’s scroll wheel towards you. The view of the IFC model zooms out: 
 

 
 

3. Stop moving the scroll wheel when the IFC model appears at the required zoom level. 
 

 
 

14.4.2 Navigating around IFC models in perspective mode 

 

Moving an IFC model around 
If your mouse is equipped with a scroll wheel, you can use this to move an IFC model upwards 
and downwards. When you move an IFC model around in perspective mode, your viewpoint 
over the model changes as the model moves. For example, if you are currently looking at the 
base of a building and you move the model downwards, your viewpoint gradually shifts as the 
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IFC model moves so that you eventually find yourself looking at the roof of the building. This is 
illustrated below, in a sequence of images in which an IFC model is being moved downwards: 
 

 
 
To move an IFC model around, move the mouse’s scroll wheel towards you to move the model 
upwards, and move it away from you to move the model downwards. Your viewpoint shifts 
slightly each time you move the wheel and the model moves. 
 
Rotating an IFC model in relation to a fixed point 
When viewing an IFC model in perspective mode, you can rotate it in relation to a fixed point of 
your choosing. In practice, this enables you to “look” around the model, as if you were turning 
your head or moving a camera. 
 
To rotate an IFC model in relation to a fixed point: 
 

1. Click and hold down the left mouse button on the IFC model at the point in relation to 
which you want to rotate the model. A dot indicating the fixed point appears at the point 
at which you have clicked. In the illustration below, the left mouse button has been 
clicked and held down in the middle of the IFC model: 
 

 
 

2. Keeping the left mouse button held down, drag the mouse around. The IFC model 
rotates in relation to the fixed point, which remains highlighted by 
the dot in the pane: 
 

 
 

3. Release the left mouse button to stop rotating the model.  
 
Note that you can click and hold down the left mouse button at a point that is outside the 
confines of the IFC model, as illustrated below. Experiment with the location of the fixed point to 
get the type of rotation that you want: 
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Zooming in and out of and “walking around” an IFC model 
 
When viewing an IFC model in perspective mode, you can zoom in and out of it, and “walk 
around” it. 
 
To zoom into an IFC model, as if you were walking towards it: 
 

1. Click and hold down the right mouse button on the IFC model at the point at which you 
want to zoom in. A dot appears on the model at the point at which you have clicked. In 
the illustration below, the right mouse button has been clicked and held down at the 
doorway at the front of the building. This is the point at which the model will zoom in: 

 

 
 

2.  Keeping the right mouse button held down, drag the mouse towards you. The IFC 
model zooms into the point at which you clicked, which remains highlighted by the dot 
on the model: 

 
 

 
 

3. Stop dragging the mouse and release the right mouse button when the IFC model 
appears at the required zoom level; if you move the mouse around while zooming in, 
the focal point of the zoom changes. 
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Unlike when zooming in when in orthogonal mode, if you zoom far enough into an IFC model 
when in perspective mode, you enter the building itself and are able to view – and “walk 
through” the building’s interior. 
 
You can also zoom into an IFC model in perspective mode by pressing the UP arrow key on the 
keyboard. 
 
To zoom out of an IFC model, as if you were backing away from it: 
 

1. Click and hold down the right mouse button on the IFC model. A dot appears on the 
model at the point at which you have clicked. 

 
2. Keeping the right mouse button held down, drag the mouse away from you. The IFC 

model zooms out: 
 

 
 

3. Stop dragging the mouse and release the right mouse button when the IFC model 
appears at the required zoom level. 

 
You can also zoom out of an IFC model in perspective mode by pressing the DOWN 
arrow key on the keyboard. 
 
To "walk around" an IFC model: 
 

1. Click and hold down the right mouse button on the IFC model. A dot appears on the 
model at the point at which you have clicked. 

 
2. Keeping the right mouse button held down, drag the mouse around. The IFC model 

moves as if you were “walking around” it. You can combine left/right and 
forwards/backwards mouse movements to “walk around” the model: 
 

 
 

3. Stop dragging the mouse and release the right mouse button when the IFC model 
appears as required. 
 

Again, if you zoom far enough into an IFC model when in perspective mode, you enter the 
building itself and are able to view – and “walk through” the building’s interior. 
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14.4.3  “Walking through” the interior of an IFC model 

 
When you view an IFC model in perspective mode, you can “walk through” the building and see 
what it looks like from the inside. 
 
Before you can “walk through” the interior of a model, you need to “get inside” the building. To 
do this: 
 

1. Click and hold down the right mouse button on the IFC model at the point at which you 
want to zoom in. A dot appears on the model at the point at which you have clicked. In 
the illustration below, the right mouse button has been clicked and held down at the 
doorway at the front of the building. This is the point at which the model will zoom in: 

 

 
 

2. Keeping the right mouse button held down, drag the mouse towards you. The IFC 
model zooms into the point at which you clicked, which remains highlighted by the dot 
on the model: 

 

 
 
3. Zoom in far enough until you enter the building. At this point, stop dragging the mouse 

and release the right mouse button. You should now be able to see the interior of the 
building: 
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You can now “walk through” the building using the same controls as you use to navigate around 
the outside of a model in perspective mode: 
 

 “Look around” the model, as if you were turning your head or moving a camera, by 
clicking and holding down the left mouse button then dragging the mouse around. 
Alternatively, hold down CTRL and use the arrow keys on the keyboard to “look 
around”. 

 

 “Walk around” the model by clicking and holding down the right mouse button then 
dragging the mouse around. Alternatively, hold down SHIFT and use the arrow keys on 
the keyboard to “walk around”. 

 

 Walk forwards (zoom in) by clicking and holding down the right mouse button and 
dragging the mouse towards you. Alternatively, press the UP arrow key on the keyboard 
to walk forwards. 

 

 Walk backwards (zoom out) by clicking and holding down the right mouse button and 
dragging the mouse away from you. Alternatively, press the DOWN arrow key on the 
keyboard to walk backwards. 

 

 Move the camera to the left or right by clicking and holding down the right mouse button 
and dragging the mouse to the left or to the right. Alternatively, press the LEFT or 
RIGHT arrow keys on the keyboard to move the camera to the left or right. 

 

14.4.4 Returning an IFC model back to its initial position 

Occasionally, you may get “lost” when manipulating an IFC model. If this happens, you can 
“reset” the camera to return the IFC model back to its initial position. 
 
To reset the camera, do either of the following: 

 In the toolbar of the Local IFC Files or Eleco BIM Cloud pane, click  . 

 Right-click the Local IFC Files or Eleco BIM Cloud pane and select Reset Camera 
from the menu that appears. 

 
 
 

14.5 Grouping objects in an IFC model 

If you are working with an IFC model that is stored in the Elecosoft BIMCloud, you can create 
your own groups and use these to group together – or categorise – objects in the IFC model in 
a way that suits you. This may be useful in a number of circumstances. One particular situation 
in which groups can be useful is if a mistake has been made when an IFC model was created 
and some of the objects in the IFC model have been assigned the wrong IFC entity (for 
example, doors with an IFC entity “IfcBeam”, or railings with an IFC entity of “IfcColumn”). In this 
situation, you could create a group to categorise the objects that have been assigned the wrong 
IFC entity, and use the new group when you “take off” objects from the IFC model into an 
estimation. You cannot group objects in IFC models that are stored locally. 
 
There are a number of ways to create groups and specify the objects within them, as described 
below. 
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14.5.1 Creating a group that contains all selected objects 

To create a group that contains all of the objects that are currently selected: 
 

1. Holding down CTRL, left-click the objects in the IFC model that you want to select. The 
selected objects appear in the Selections tab within the Eleco BIM Cloud pane, as 
illustrated below: 
 

 
 

2. In the toolbar of the Eleco BIM Cloud pane, click  . The New Group dialog 
appears, with the selected objects already added to the group: 

 

 
 

3. Enter a name and description for the group in the Name and Group fields and click 
OK. 
 

14.5.2  Creating a group that contains all objects that meet the criteria of a 

filter 

To create a group that contains all of the objects that meet the criteria of a filter: 
 

1. In the toolbar of the Eleco BIM Cloud pane, click  . The BIM Object Filter dialog 
appears: 
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2. Enter a name and description for the filter, use the fields on the Search Criteria tab to 
specify the filter criteria, then click OK. The new filter is added to the Filter list on the 
Categories tab within the Eleco BIM Cloud pane. 
 

3. In the Categories tab, click the new filter. All of the objects that meet the filter criteria 
are selected automatically. 

 

4. In the toolbar of the Eleco BIM Cloud pane, click . The New Group dialog appears, 
with the selected objects already added to the group. 
 

5. Enter a name and description for the group in the Name and Group fields and click OK. 

 

14.5.3 Creating a group and dragging and dropping objects into it 

To create a group and drag and drop objects into it: 

1. In the toolbar of the Eleco BIM Cloud pane, click . The New Group dialog appears: 
 

 
 

2. Enter a name and description for the group in the Name and Group fields. 
 
3. Holding down CTRL, left-click the objects in the IFC model that you want to add to the 

group. 
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4. Still holding down CTRL, click and drag the selected objects into the New Group 

dialog, where they are added to the group: 
 

 

14.5.4  Editing an existing group 

Once you have created a group, it appears in the Group list on the Categories tab within the 
Eleco BIM Cloud pane. Right-click a group to edit it – for example, to change its name or to drag 
and drop more objects into it – or to delete it as required. 
 
 
 

14.6 “Taking off” objects from an IFC model into an 

estimation 

In order to build up an estimation from an IFC model, you can “take off” objects from the IFC 
model into the associated estimation. You can then enter detailed estimations for each of the 
objects that you take off. You can choose to take off all objects, all visible objects, or selected 
objects from an IFC model. 
 
There are two main ways of taking off objects from an IFC model: 
 

 You can configure one or more “takeoff templates” to specify the way in which different 
categories of objects are taken off from IFC models, then take off objects using a 
takeoff template. 
 
When you configure a takeoff template, for each category of object you canspecify: 
 

o The IFC elements in which an object’s name, notes, code etc are stored. 
 

o The IFC element in which an object’s quantity is stored, and the unit of measurement – 
or whether to determine the quantity by the actual number of objects. 

 
o The way in which multiple objects should be merged during the take off. 
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 You can take off objects directly from an IFC model using drag and drop. 
 

Both methods of taking off objects are described below. 
 
 

14.6.1 Taking off objects from an IFC model using a takeoff template 

 

Before you take off objects using a takeoff template, you must click the dropdown to the right of 

the control in the Local IFC Files or Eleco BIM Cloud pane and select Create quantity 
posts, to specify that new quantity postings should be created in the net sheet for each item that 
is taken off, with links to the object in the IFC model. 
 
Configuring a takeoff template 
Before configuring a takeoff template for the first time, it is helpful to view the naming 
conventions that the designer has used in the IFC model. To do this, select objects one by one 
in the IFC model and view information about the selected objects using the properties tabs of 
the Local IFC Files or Eleco BIM Cloud pane. 
 
Make a note of the IFC fields that you want to import. Keep selecting objects and viewing their 
information until you have noted all of the IFC fields that you want to import. 
 
To configure a takeoff template: 

1. In the toolbar of the Local IFC Files or Eleco BIM Cloud pane, click  . The Takeoff 
Editor dialog appears: 
 

 
2. The left pane of the dialog lists all available takeoff templates. Select a template to edit 

its details, or click  to create a new template, in which case a dialog appears in which 
you can enter the template’s name. 
  
The right pane of the dialog displays a row for each category of object in  the IFC model 
that is currently open. You carry out the following steps for each category. 

 
3. In the Name and Note columns – and in other similar columns, if required –click the 

grey box to the right of the cell. The Select Properties dialog appears: 
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4. In the left pane of the dialog, select the IFC element in which the name, notes, etc is 

stored for objects of that category and click OK to close the Select Properties dialog. 
 

5. If the quantity of an object is stored in an IFC element, click the grey box to the right of 
the cell in the Quantity column and select that IFC element; otherwise, leave this 
column set to “<Count>”, meaning that the quantity of this category of object will be 
determined by the actual number of objects. 
 

6. If you want to merge items of a particular category together during the take-off, click the 
grey box to the right of the cell in the Merge Criteria column. The Select Properties 
dialog appears. Select the IFC elements that you want to take into account when 
merging objects of this category, then click OK. For example, if you select two IFC 
elements, objects of this category for which the two selected IFC elements are identical 
will be merged into one item during the take-off. This is useful if an IFC model contains 
a large number of identical items – columns, ceiling tiles, wooden joists, etc – that you 
want to appear in Bidcon as a single object for estimating purposes. 
 

7. When you have finished configuring the takeoff template, close the Takeoff Editor 
dialog. 
 

 

Using a takeoff template to take off objects from an IFC model 
 
To take off objects from an IFC model using a takeoff template: 
 

1. In the net sheet, select the group into which you want the objects that you are going to 
take off to appear. 
 

2. In the toolbar of the Local IFC Files or Eleco BIM Cloud pane, click the dropdown to 

the right of the  control and specify whether you want to create groups for the 
resulting parts in the net sheet at domain level (“Building Elements”, ”Facilities”, etc), 
at type level (“IfcPlateType”, “IfcWindowStyle”, etc), at both domain and type level, or 
at neither level. 
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3. In the toolbar of the Local IFC Files or Eleco BIM Cloud pane, select the takeoff 
template that you want to use during the take-off from the dropdown list. 
 

4. If you have already taken off some objects and wish to view only those objects that 

have yet to be taken off, click the dropdown to the right of the  control and select 
Hide Imported. 
 

5. If you want to take off selected objects only, select the objects that you want to take off. 
 

6. Click the drop-down to the right of the  control and select “All”, “Visible” or 
“Selected”, depending on which objects you want to take off. 

 

7. Click  . The objects are taken off from the IFC model and appear in the net sheet of 
the estimation, with objects merged according to the merge criteria in the selected 
takeoff template. 

 
8. Repeat the above steps until all of the required objects have been taken off.  

 

 
The Summary tab of the Local IFC Files or Eleco BIM Cloud pane displays an overview of all 
of the object types within the IFC model and shows how many have yet to be taken off. Bidcon 
retains this information so you can work on different parts of the model at your convenience: 
you do not need to take off all objects in one work session. 

 

 
The objects that you have taken off the IFC model appear initially in the net sheet as quantity 
postings – ie “rogue items”. You need to convert the quantity postings into work results or 
design elements before their quantities are included in the estimation. Refer to section 7.3.3, 
Exchanging postings in the spreadsheet, for details of how to do this. 
 

14.6.2 Taking off objects from an IFC model using drag and drop 

As an alternative to using takeoff templates to take off objects from IFC models, you can take 
off objects using drag and drop. 
 
Before you take off objects using drag and drop, you must specify the way in which the net 
sheet should be updated when you take off objects in this way. You can specify that either: 
 

 New quantity postings should be created in the net sheet for each item that is taken off, 
with links to the object in the IFC model. This is most useful if you are using an IFC 
model to build up a new estimation. 

 

 Information from the object that is being taken off is either added to, or replaces, 
information in the existing line item in the net sheet onto which the object is dragged 
and dropped. This is most useful if you are working with an existing estimation and want 
to update it with information from an IFC model. 

 
To specify the way in which the net sheet should be updated when you take off objects using 
drag and drop, in the toolbar of the Local IFC Files or Eleco BIM Cloud pane click the 

dropdown to the right of the  control and select the appropriate option. 
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To take off objects from an IFC model using drag and drop to create new quantity postings: 
 

1. In the toolbar of the Local IFC Files or Eleco BIM Cloud pane, click the dropdown to 

the right of the  control and select Create quantity posts. Note that you only need 
to do this once. 
 

2. Locate the part to which you want to add one or more quantity postings in the net sheet. 
 

3. Select the object in the IFC model that you want to take off using drag and drop – you 
can select more than one object at the same time by holding down CTRL and clicking 
more than one object. 

 
4. Hold down CTRL and click and drag the selected object(s) to the part in the net sheet to 

which you want to add one or more quantity postings. New quantity postings relating to 
the selected objects are created. 

 
 
To take off objects from an IFC model using drag and drop to update existing line items: 
 

1. In the toolbar of the Local IFC Files or Eleco BIM Cloud pane, click the dropdown to 

the right of the  control and select Apply quantities. Note that you only need to do 
this once. 
 

2. Locate the line item that you want to update with information from one or more objects 
from the IFC model. 

 
3. Select the object in the IFC model that you want to take off using drag and drop – you 

can select more than one object at the same time by holding down CTRL and clicking 
more than one object. 

 
4. Hold down CTRL and click and drag the selected object(s) to the line item in the net 

sheet that you want to update. The Quantity Takeoff dialog appears: 

 

 
 

5. In the Quantity field, select the information that you want to take off from the object(s) 
in the IFC file; select “Advanced” in this field if you want to write a formula to specify 
exactly how information is taken off. 
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6. Click either the Add or Replace radio button to specify whether the quantity information 
should be added to the existing line item, or whether it should replace the information in 
the line item. 

 
7. Click OK. The line item is updated with information that you have taken off from the 

object(s) in the IFC model. 
 

Taking off information in this way enables you to take off different items of information from the 
same object in an IFC model and apply them to different line items. For example, if an object in 
an IFC model represents a concrete slab, you may want to take off information about the 
volume of the concrete (in m3) to one line item, and information about the area of the damp 
protection (in m2) to another line item. 
 
 
 

14.7 Updating IFC models with cost information from 

Bidcon 

If you are working with an IFC model that is stored in the Elecosoft BIMCloud, you can update it 
with the cost information that you have entered into Bidcon. You may want to do this in order to 
pass the IFC model onto another stakeholder who needs the cost information that you have 
entered into Bidcon. 
 
You cannot update IFC models that are stored locally with cost information from Bidcon. 
 
To update an IFC model in the Elecosoft BIMCloud with cost information from Bidcon, in the 

toolbar of the Eleco BIM Cloud pane, click  . 
 
 
 

  Working with rates 15
Using Bidcon, you can specify a rate factor for each resource type in order to calculate a rate for 
each spreadsheet item, as opposed to the net price of each item. The rate is calculated by 
multiplying the net price by the rate factor that you specify. Once you have specified one or 
more rate factors, both the net price and the rate of items are displayed in the net sheet. You 
can either enter rate factors manually, or let Bidcon calculate them automatically. 
 
One purpose of using rate factors is to allocate overhead costs that are recorded in the 
summary and to report these in a-price terms to your customers. 
 As far as possible, you should ensure that an estimation is complete before starting work on 
rate management. 
 
To be able to work with rates effectively, you must ensure that the net sheet is able to display 
columns that show the rate of items. If these columns do not appear, you can display them as 
follows: 
 

1. In the net sheet toolbar, click  . The Column Customisation dialog appears: 
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2. Ensure that the Hidden check box is cleared for those columns that refer to rates, then 
click OK. 

 
 
 

15.1 Recording rate factors for resources 

To record a rate factor for each resource: 
 

1. From the Estimation menu, select Rate Management. The Rate Management dialog 
appears: 

 

 
 

2. Specify the way in which you want the tender total to be calculated in the Specify 
desired tender total field. You can specify a calculation method, select “No tender total 
value”, or select “Specify manually” if you want to enter a tender total without it being 
calculated. If a total is specified, Bidcon will apply factors to resources to reach the 
desired total. 
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For each resource, enter the factor by which to multiply the net price of the resource in 
order to calculate the total rate to be used in tenders in the Factor column. For 
example, enter 1.2000 to multiply the net price by 1.2. 
 

3. Once you have entered a factor for a resource, the check box in the Locked column is 
selected automatically to ensure that the resource is not affected by any subsequent 
changes that you make to other resources. 

 
4. Select “Generate Unitprice (S)/Unit” in the Function field, then click Update. 

 
5. Click OK. 

 
The net sheet now displays both the net price and the rate of items and you can see that the 
rates of items have been calculated according to the factors that you have specified. From this 
point on, you can adjust rates manually. 
 
 
 

15.2 Applying rate management following changes in 

the net sheet 

Once you have recorded rate factors, you can adjust rate manually. If you do so, or if there is 
any other change in an estimation that affects or changes the value of a tender, the following 
happens: 
 

 All values are deleted from the rate-related columns in the net sheet (except for any 
items that you have locked in the net sheet by selecting the Locked rate check box). 

 

 A button with a warning in red appears, informing you that you must update the rates: 
 

 
 
Click this button to refresh the rates in the net sheet. If you forget to refresh rates, you are 
warned that the tender sum has altered when you come to print a spreadsheet-related report or 
export information from Bidcon. 
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  Working with trade codes 16
You can configure your own “trade codes” in Bidcon, to be used as an alternative to other codes 
and to summarise estimation items in your own way. You might find it useful to set up trade 
codes to represent the departments in your organisation, or the types of subcontractor that are 
used. If you organise items according to trade code, you can make selections and summarise 
according to trade codes when printing. 
 
You can choose to create trade codes that are unique to each spreadsheet (this is the most 
common way of using trade codes), or to create a series of trade codes in the system database 
that can be applied to items in all of your estimations. 
 
Trade codes can comprise letters, numbers and other characters. You create trade codes by 
typing them directly into the Trade Code column into a spreadsheet:  
 

 
 

If the Trade Code column is not currently displayed, click  to display the Column 
Customisation dialog and clear the Hidden check box for that column. 
 
Alternatively, you may want to create a hierarchy of trade codes to assign to items. 
 

1. From the Estimation menu, select Trade Code. The Trade Code dialog appears: 
 

 
 

2. Click  . The Add Trade Code dialog appears: 
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3. Enter a code and a description for the trade code, then click OK. The trade code 
appears in the Trade Code dialog. 

 
4. Repeat the above two steps to create as many trade codes as you need; you can build 

up a hierarchy of trade codes by selecting a trade code in the left pane before clicking 

  in order to create a trade code that is subordinate to the selected code; click View 

All before clicking  to create a new trade code at the top level of the hierarchy. 
 

5. Click Close when you have created all of the trade codes that you need.  

 

Once you have created a hierarchy of trade codes, you can assign them to items in a 
spreadsheet. To do this: 

1. In the row of an item to which you want to assign a trade code, click the  box in the 
Trade Code column. The Trade Code dialog appears. 
 

2. Select the trade code to assign to the item, then click  . The code is assigned to the 
item in the spreadsheet. 
 

To create a hierarchy of trade codes in the system database that can be applied to items in all 
of your estimations, follow the instructions above, but instead of selecting the Trade Code 
command from the Estimation menu, select the Trade Code command from the System 
menu. 
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  Creating a custom template project 17
You can create template projects of your own in Bidcon, which you can populate with data that 
is relevant to your organisation and to the estimations that you produce. You can then use these 
templates to create estimations in Bidcon. Basing estimations on templates saves you time, as 
storing much of the information in a template saves you from having to enter it into each 
individual estimation that you produce. 
 
To create a custom template project: 
 

1. Create an estimation that contains the information that you want to save as a template. 
You may want to base this estimation on an existing template. 

 
2. From the File menu, select Save as Template. The Save As dialog appears. 

 
3. With “Template Files (*.bne)” selected in the Save as type field, enter a name for the 

template in the File name field and click Save. 
 
The template is saved into Bidcon’s templates folder. You can now use the template 
to create new estimations. 
 
 
 

  Importing and exporting data 18
You can import a variety of data from external applications into Bidcon and you can export data 
out of Bidcon into formats that can be read by other applications. 
 
 
 

18.1 Importing data into Bidcon 

You can import a variety of data into Bidcon. For example, you can import other users’ Bidcon 
settings, bills of quantity, and price lists. 
 
Before you import data into Bidcon, you need to map the information that you want to import. 
You do this by clicking the File menu and selecting Add/Edit Import Formats. 
 
To import data into Bidcon: 

1. From the File menu, select Import. The Import Wizard appears: 
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2. The Import Wizard comprises a number of steps, which differ according to the type of 

information you are importing. 
 

3. Select the type of data you are importing, for example “User settings” or “Bill of 
quantities” in the Import type field. 

 
4. Work through the steps in the wizard to select the import format and to select the data 

that you want to import, clicking Next to move between each step as required. 
 
After completing the final step of the wizard, click Finish to close the wizard and import the data 
into Bidcon. 
 
 
 

18.2 Exporting data out of Bidcon 

You can export data out of Bidcon spreadsheets in a variety of formats. For example, you can 
export data in Bidcon’s own BNE format – for subsequent import into another Bidcon estimation 
– in XML format and in Asta Powerproject format. 
 
To export data out of Bidcon: 
 

1. Open the spreadsheet that you want to export. 
 

2. From the File menu, select the Export Estimation submenu, then select the type of 
export that you want to carry out. 

 
3. If you choose to export the data to “File” (ie Bidcon’s own BNE format) or to “XML”, the 

Save As dialog appears, in which you can enter a location and filename for the 
exported data; if you choose to export in another way, the Export Wizard appears. 
 
The Export Wizard comprises a number of steps, which differ according to the type of 
export you are carrying out. The following instructions assume that you are exporting 
data in Asta Powerproject format and that the first page of the Export Wizard has 
appeared: 
 

 
 

4. In the Include field, specify whether you want to export everything in the spreadsheet 
or whether you want to export only the data that matches a set of filter criteria. 
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5. If you have chosen to export data that matches a set of criteria, click  .The Add 
Selection dialog appears: 

 

 
 

6. Enter an ID and name for the filter criteria in the Selection ID and Name fields. 
 

7. In the Estimation sheet group of fields, select the check boxes next to the 
spreadsheets from which you want to export data. 

 

8. All data from each spreadsheet is exported, unless you click  to the right of the 
spreadsheet name, in which case a dialog appears in which you can select one or more 
specific parts from within the spreadsheet to export. 
 

9. Use the remaining fields on the Add Selection dialog to specify filter criteria to narrow 
down the data that is exported, then click OK to return to the Export Wizard, where 
your filter criteria appears in the Selections group: 

 

 
 

10. Click  to add more filter criteria if required, then select the check box to the left of 
each criterion that you want to use in this particular export process. 
 

11. Click Next. The second page of the Export Wizard appears: 
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You use this page of the wizard to specify the way in which the exported data will be 
ordered hierarchically when imported into Asta Powerproject. You can specify up to six 
levels of hierarchical ordering in the fields on this page. The options that are available 
for each level of the hierarchy depend on the options that you selected on the previous 
page of the wizard. 
 

12. Specify the way in which the data will be ordered hierarchically, then click Next. The 
third page of the Export Wizard appears: 
 

 
  

You use this page of the wizard to specify the way in which exported resources and 
costs will be represented when imported into Asta Powerproject. For example, you may 
want individual permanent resource records to be created for each Bidcon labour 
resource, or you may all labour resources represented by a single permanent resource 
record in Asta Powerproject. 

 
13. Specify the way in which resources and costs are represented, then click Finish. A 

message appears when the export is complete. 
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  Sending estimations as email attachments 19
If you have Microsoft Outlook® installed on your computer, you can send estimations as email 
attachments.  
 
To do this: 
 

1. Open the estimation that you want to attach to an email. 
 

2. From the File menu, select Send Estimation to – Email Recipient. A new Microsoft 
Outlook email is created, with the estimation file attached. You can now send the 
estimation to one of your email contacts. 
 

 
If you are experiencing a problem with an estimation and you want to send it to the 
Technical Support department, select Send Estimation to – Customer Support 
(Email) from the File menu. 
 
 
 

  Configuring Bidcon settings 20
You can configure Bidcon in a variety of ways to best suit the way in which you work, as 
described in the following sections. 
 
 
 

20.1 Configuring the columns in a spreadsheet table 

You can change the appearance of the tables that appear within Bidcon’s spreadsheets. For 
example, you can customise the titles of the column headings, specify the width of columns and 
the number of decimal places that are displayed, hide columns that you do not want to display 
and specify the order in which columns are displayed. 
 
To configure the columns in a spreadsheet table: 
 

1. In the toolbar of the appropriate spreadsheet, click  . The Column Customisation 
dialog appears: 
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2. Configure the columns as follows: 
 

 Click  to resize the columns automatically to fit the data that they display. 
 

 Select a column and click  or  to change the order in which the columns appear 
in the table: the column at the top of the list in this dialog appears at the far left of the 
table and the column at the bottom of the list appears at the far right. 

 

 Enter different titles for columns in the Column Caption row. 
 

 Specify custom widths for columns in the Width row. 
 

 Specify the number of decimal places to display in columns in the Decimals row. 
 

 Specify the way in which to align text in columns in the Alignment row. 
 

3. Click OK. 
 

If you want to reset the columns in a spreadsheet table to their default settings, access the 

Column Customisation dialog again and click  . 
 
 
 

20.2 Configuring Bidcon’s general settings 

You can configure a number of general settings that affect the way in which Bidcon works. 
 
To configure Bidcon’s general settings: 
 

1. From the Tools menu, select Options. The Database tab of the Options dialog 
appears: 
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This tab displays information about your installation of Bidcon; you cannot change any 
of the information on this tab. 
 

2. Click the Regional Language tab: 
 

 
 
You can use the fields on this tab to configure the language, currency, date and time 
formats and decimal and thousand separators. 
 

3. Click the Paths tab: 
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4. This tab displays the locations in which various types of file are stored. To change a 

location, click in the appropriate row and click the  button that appears. 
 

5. Click the User Settings tab: 

 
 

You can use the fields on this tab to configure a variety of user-specific settings, including the 
colours that are used to indicate the different types of item in Bidcon. 
 

6. Click the System Settings tab: 

 
 
You can use the fields on this tab to configure a variety of system settings; note in 
particular the following fields: 

 

 Use the Check for Update and Update interval fields to configure the frequency with 
which Bidcon checks for software updates. 

 

 In the System protection level field, select “Low” to give all users access rights to do 
everything in Bidcon, or select “High” to specify that only a few users have 
“Administrator” access rights and that most users have lesser “User” access rights. Do 
not select “High” unless you are an Administrator and you know your user name and 
password. You can control user groups by clicking the System menu and selecting 
Manage Users/Groups. 
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 Use the Synch WR description to tender resource field to specify whether it should be 
possible to automatically map the names of resources to the names of the work results 
of which they are a part. If you select “Yes” in this field, a Mapped Name column 
appears in a number of dialogs, which enables you to do this. 

 

 Use the Standard price for labour resource – Active field to specify whether or not to 
apply a default cost per hour for all labour resources. If you select “Yes” in this field, you 
can enter a system-wide default cost per hour in the Standard price for labour resource 
– Price field on this dialog, or leave this field blank and enter a default cost per hour for 
each individual estimation in the General price for resource type labourer field on the 
Estimation Properties dialog. If you are using Spon’s price books in your estimations, 
it is best not to enter a default cost per hour, as the cost per hour will be taken from the 
price books themselves. 

 
7. Click OK when you have finished configuring Bidcon’s general settings. 
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You can use “drag and drop” in a number of situations in Bidcon. For example, you can drag 
and drop items from reference books into spreadsheets and you can drag and drop items from 
one spreadsheet to another – and from one estimation to another. You can drag and drop using 
the left or the right mouse button; different options are available to you depending on which 
button you use. 
 
Note the following points about dragging and dropping: 
 

 In order to drag and drop a row, you must select the entire row: it is not enough to 
select a single cell. 

 If you select an estimation part or group, it is treated as a number of selected rows. 

 If you select a resource, it is treated as a selected row. 

 You can CTRL-click a selected row to deselect it.  
 
Some examples of dragging and dropping are illustrated below. 
 
 
 

21.1 Copying a single spreadsheet row using the left 

mouse button 

To drag and drop a single row by dragging and dropping using the left mouse button: 
 

1. Enter row selection mode by either clicking or by right-clicking  a row and selecting 
Select row(s) from the menu that appears. When you are in row selection mode, the 

 button appears depressed and spreadsheet cells are locked to prevent editing. 
 

2. Click the row that you want to drag and drop. The row is selected. Rather than entering 
row selection mode, you can select individual rows by clicking the icons that appear at 
the far left of each row. 
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3. Use the left mouse button to drag and drop the selected row to the desired location. 

Note that the mouse pointer appears like this –  – while you are dragging and 
dropping. 

 
4. A dialog appears when you drop the selected row. Enter a quantity in the dialog and 

click OK. The row is copied to the new location with the quantity that you have entered. 
 

5. Click  again to leave row selection mode. 
 

 

 

21.2 Copying multiple spreadsheet rows using the 

left mouse button 

To drag and drop multiple rows by dragging and dropping using the left mouse button: 
 

1. Enter row selection mode by either clicking  or by right-clicking a row and selecting 
Select row(s) from the menu that appears. 
 

2. Click the rows that you want to drag and drop. The rows are selected. Rather than 
entering row selection mode, you can select multiple rows by holding down CTRL and 
clicking the icons that appear at the far left of each row. 

 
3. Use the left mouse button to drag and drop the selected rows to the desired location. A 

menu appears when you drop the selected rows, asking whether you want to copy the 
rows or cancel the operation. 
 

 
4. Click Drop objects. The rows are copied to the new location. You can now edit the 

copied rows and enter a different quantity if required. 
 

5. Click  again to leave row selection mode. 
 

 

 

21.3 Copying a single spreadsheet row using the 

right mouse button 

To drag and drop a single row by dragging and dropping using the right mouse 
button: 

1. Enter row selection mode by either clicking  or by right-clicking a row and selecting 
Select row(s) from the menu that appears. 
 

2. Click the row that you want to drag and drop. The row is selected. Rather than entering 
row selection mode, you can select individual rows by clicking the icons that appear at 
the far left of each row. 
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3. Use the right mouse button to drag and drop the selected row to the desired location. A 

menu appears when you drop the selected rows, asking whether you want to post the 
row, copy the row, move the row or cancel the operation. “Posting” the row means 
copying it with the option to change the quantity; “copying” it means copying it as is, 
without the option to change the quantity. 

 
4. Select the option you require. 

 
5. If you choose to post the row, a dialog appears when you drop the selected row. Enter a 

quantity in the dialog and click OK. 
 

6. Click  again to leave row selection mode. 

 

 

 

21.4 Copying multiple spreadsheet rows using the 

right mouse button 

To drag and drop multiple rows by dragging and dropping using the right mouse 
button: 

1. Enter row selection mode by either clicking  or by right-clicking a row and selecting 
Select row(s) from the menu that appears. 
 

2. Click the rows that you want to drag and drop. The rows are selected. Rather than 
entering row selection mode, you can select multiple rows by holding down CTRL and 
clicking the icons that appear at the far left of each row. 

 
3. Use the right mouse button to drag and drop the selected row to the desired location. A 

menu appears when you drop the selected rows, asking whether you want to copy the 
rows, move the rows or cancel the operation. 
 

 
4. Select the option you require. The rows are copied or moved to the new location. You 

can now edit the copied or moved rows and enter a different quantity if required. 
 

5. Click  again to leave row selection mode. 

 

 

 

  Updating estimations from the tender phase 22
to the production phase 

 
When a project enters the production phase and you want to manage this phase within Bidcon, 
you should change the estimation phase from the tender phase to the production phase. Once 
you change the phase of an estimation, you cannotrevert back to an earlier phase. Because of 
this, you must back up an estimation before changing its phase. 
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To change the phase of an estimation: 
 

1. Right-click the estimation in the Estimation Explorer and select Change Phase from 
the menu that appears. The Change Phase dialog appears: 

 

 
 

2. Click Backup. The Save As dialog appears, in which you can enter a location and 
filename for the backup of the estimation. 

 
3. Once you have backed up the estimation, select the appropriate phase in the Phase 

field in the Change Phase dialog and click OK. The tender phase of the estimation is 
locked and the estimation enters its production phase. 
 

 

 

  Creating customised reports 23
As an alternative to using the standard system reports that are supplied with Bidcon, you can 
create customised reports. You do this by copying a system report and editing the copy to 
configure it to include the information that you want. 
 
You can create and maintain your own custom and personal reports, which you can then use in 
multiple estimations. Custom reports are available to all users in the current database; personal 
reports are available to you only. 
 
To create a customised report: 
 

1. From the File menu, select Print – Reports. The Report Templates dialog appears: 

 
Each row in the dialog represents a different report. 



23 Creating customised reports 

74 

 

2. Select the report on which you want to base your new customised report and click  . 
The Edit Report dialog appears. 

3. Click the dropdown to the right of the  control and select Copy as Custom or Copy 
as Personal – depending on whether you want to make the new report available to all 
users in the current database or to yourself only. The Add Report dialog appears, 
displaying details of the report copy 
. 

4. Use this dialog to edit the copy of the report as required: 
 

 Use the General tab to specify the type of report, its name and description, the printer 
with which it should be output and the template that should be applied to it. 

 

 Use the Column Selection tab to specify the columns of information that should be 
included in the report. 

 

 Use the Group Order tab to specify the way in which information should be grouped 
and sorted in the report. For example, you may want to group information by variation, 
then by trade code. You can display summary rows for each level of grouping and you 
can specify whether items without the code(s) by which you are grouping should be 
included or excluded. 

 

 Use the Margin and Header tab to specify a textual header for the report, to specify its 
orientation and margins and to add a corporate logo to the report. 

 
5. Click OK to save your changes to the customised report. 

6. If the report is not visible in the Report Templates dialog, click  and select All 
from the menu that appears to display system-wide reports, custom reports and 
personal reports. 
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